
Handy Tips to Create Better Spreadsheets 
and Work with Them More Easily

As I’m sure you’ve discovered, Microsoft Excel doesn’t
have to be complicated. It’s just a matter of entering
your figures and adding simple formulas to perform
calculations on them. But no matter what your level
of experience with Excel, there are sure to be options
and methods you haven’t come across that make
things easier, and in this article you’ll find our pick of
all the most useful.
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This article shows you how to:

� Work more efficiently using practical Excel tips

� Make spreadsheets easier to read and understand

� Reach useful options quickly when you need them
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Rename and Colour-code Worksheet Tabs
When you start Microsoft Excel and click on Blank work-
book, it creates a new, unnamed spreadsheet document for
you. This document consists of a single worksheet named
Sheet1, and you can see that sheet’s tab at the bottom-left
of the Excel window. But a single document can contain any
number of these sheets.

It can make a lot of sense to use multiple worksheets within
a single file (and you can add a new worksheet at any time
by pressing + ). It means that you can keep
related details together in a single spreadsheet file, making
it easy to refer to older figures without having to find and
open a different file. It also means that you can write
formulas to compare or add-up the totals from the various
sheets in the file.

The one drawback is those rather anonymous titles given
to the worksheets. As an example, let’s say that you’ve
created a spreadsheet file to keep track of your energy bills, 

Shift F11
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Each worksheet
has its own tab

Multiple
worksheets in
one file saves
time

Make each sheet
easier to identify
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and you’ve used a different sheet to track each year’s
figures. Wouldn’t it be helpful to see at a glance which sheet
contained which year’s bills?

Fortunately, Excel allows you to give each tab a better
name. Here’s how to do it:
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Rename the
worksheet

:1.  Start Excel and open the file whose tabs you want to
rename. (Or, if you prefer, use the empty spread-sheet
in front of you if you’d like to experiment first!)

2.  Right-click the worksheet tab you want to rename
so that a context menu appears.

3.  Choose Rename . This highlights the name of the
tab, and you can now type a new name, such as
‘2021’, in place of the anonymous ‘Sheet’ name,
pressing when you’ve finished.

1

2

Enter

2

1
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Set colours 
for tabs

A greater choice
of colours

Keep tab 
names short!
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: 1.  Right-click the tab whose
colour you want to change.

2.  Move the mouse to the Tab
Color item and a little
colour-selection panel will
open beside it.

3.  Choose a colour for the tab
by clicking one of the little
colour swatches in either the
‘Theme Colors’ or ‘Standard
Colors’ section.

An alternative method is to select the tab you want to
rename by clicking it, and then double-click it to highlight
its name ready for changing.

Another useful way to make the tabs more recognisable at a
glance is to colour-code them. You might do this to draw
attention to important worksheets, or to mark out a sheet
that contains a different type of information to the others.

Here’s how to choose or change a tab’s colour:

If you’d like a wider choice of colours, click the More Colors
item. In the Colors dialog that appears, click the colour you’d
like to use and then click OK.

Add Headings to Groups of Cells
Although you can give each worksheet tab a more
descriptive name than ‘Sheet1’, ‘Sheet2’ and so on by follow-
ing the steps on page 3, it’s best to keep these names fairly
short: if the names are longer, the tabs become very wide,
and you’ll be forever scrolling back and forth through the
row of tabs to find the one you want!
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Add titles and
headings to the
worksheet itself

Merge a row of
cells into one

Type your
heading

:

If you’d like to add a longer description of what a worksheet
contains, there’s a better way to do it: add a heading to the
worksheet itself, above all your figures. This trick can also
be useful if your worksheet contains different groups of
figures – perhaps several columns containing expenses and
several more containing income: you can add the headings
‘Expenses’ and ‘Income’ above each group of columns.

Here’s how to do it:

1.  Make sure you have a blank row of cells above your
figures. If you don’t, right-click the 1 at the far-left
of the first row and choose Insert to insert a blank
row above your figures.

2.  In this blank row, select the cells stretching from just
above your leftmost figure to just above your
rightmost figure by clicking in the first cell and
dragging the mouse to the right.

3.  In the ‘Alignment’ group of the Ribbon’s Home tab,
click the Merge & Center button. The cells you’ve
selected are then converted into a single wide cell.

4.  Now type your heading into this cell and it will be
automatically centred above your columns of data.
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Hide or Display Cells Containing 
Zero Values
I’ll explain this with an imaginary situation. Let’s say that
you buy old furniture, smarten it up and sell it at boot sales
or even online. You want to keep track of how many items
you’ve sold each month, and how much money you’ve
made, and the obvious way to do that is to create a
spreadsheet.

You set up your spreadsheet like the example below: for
each month, you note the number of items sold and the
price they were sold for, with a simple formula in the ‘Total’
column that multiplies the number sold by the price to
produce your total income for the month.

It’s quick and easy to set up, but it has a flaw: the months
which don’t yet have any sales show their totals as 0 (zero), 
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Figures for 
each month of
the year

Future months
show a zero
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1.  Click the File tab and choose Options from the left-
hand panel.

2.  In the Excel Options window that opens, click
Advanced in the left-hand panel.

3.  Scroll down to the section headed ‘Display options
for this worksheet’.

4.  Remove the tick beside Show a zero in cells that
have zero value and click OK.
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Switch off
‘zero values’

What do the
numbers mean?

:

because the formulas in those cells are multiplying empty
cells. Rather than leaving out the formulas, you can use a
handy Excel trick to have the zero cells remain empty:

Change Number Formats Quickly 
from the Keyboard
If you create a spreadsheet like the one shown on page 6,
the columns headings tell you what the cells below them are

Even with the zero values hidden, you can still check
whether any apparently empty cells contain formulas.
Just switch to the Formulas tab on the Ribbon and click
the Show Formulas button in the ‘Formula Auditing’
section; you can click the same button a second time to
hide the formulas again.
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supposed to represent: the contents of column ‘B’ are just
ordinary numbers, whereas the figures in column ‘C’
represent amounts of money in pounds. Likewise, the totals
in column ‘D’ are also currency values.

That’s all well and good, but wouldn’t it be better if figures
in columns ‘C’ and ‘D’ actually looked like numbers in
pounds and pence, with pound symbols, decimal points, and
two digits for the pennies?

To do that, just select the two columns (or the cells in those
columns), right-click one of the selected column headers or
cells and choose Format Cells. In the dialog that appears,
choose the Number tab, click Currency in the list on the
left, and then click OK.

Rather than right-clicking, an alternative way to open this
Format Cells dialog is by pressing the key combination 

+ (the number ‘1’ key on the top row of the key-
board).

However, if you already know which number format you
want to apply to the selected columns or cells, you can select
it quickly just by typing the appropriate key combination: 

•  + + : the ‘General’ format, for numbers
with no particular format.

•  + + : the ‘Number’ format, which dis-
plays numbers to two decimal places and separates
thousands with a comma for better readability.

Ctrl 1

Ctrl #Shift

Ctrl Shift 1
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Add currency
symbols to
monetary values

The usual way

The quick way –
use the keyboard
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Set Manual Line Breaks for Text in a Cell
Once in a while you’ll want to type a fairly long line of text
into a cell. You can read the text while you’re typing it, and
the whole line remains
visible afterwards as long
as the cell to its right
remains empty. However,
as soon as you type some-
thing into its neighbouring
cell, you’ll only be able to see the beginning of the long line
of text you typed.

There’s a simple reason for this: the default formatting of a
cell doesn’t include line breaks, so Excel doesn’t try to

‘wrap’ your text on to
multiple lines. If you need
to wrap the text, making
the cell (and thus the row
containing it) taller, you
can do so easily:

To use these key combinations in a cell, the cell has to
be selected first, but not ‘active’ – in other words, you
shouldn’t be able to see the text cursor blinking in the
cell. If you can see the text cursor, just click a different
cell then click the first cell again to select it.

•  + + : the ‘Currency’ format, showing a
pound symbol and two decimal places.

•  + + : the ‘Percent’ format, displaying
the figure with a % symbol.

•  + + : the ‘Scientific’ format.

Ctrl Shift 4

Ctrl Shift 5

Ctrl Shift 6

!

A long line of
text won’t fit 
in the cell

Excel doesn’t
wrap text
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Wrap the text
wherever you
choose
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1.  Select the cell, row, column, or group of cells whose
text you want to wrap.

2.  Right-click one of the selected cells, or the header of
a selected row or column, and choose Format Cells.

3.  In the dialog that appears, switch to the Alignment tab.
4.  In the ‘Text control’ section, tick the box beside

Wrap text and click OK.

1.  Select the cell containing the long line of text.
2.  Position the text cursor immediately before the word

that should be moved down to a new line.
3.  Press the key combination + : this inserts

a line break before that word. In the example below,
a line break has been inserted before the word ‘a’.

4.  Do the same anywhere else in the cell if you need to
create more line breaks in the text.

5.  Press when you’ve finished to keep the changes.Enter

EnterAlt

If you want to undo the text wrapping, select the same
cell(s) again, go back to the Format Cells dialog and
remove the tick you added in step 4.

Using the method above, however, the text won’t necessarily
be wrapped in the way you like. In addition, the need to
select, right-click, and then navigate the Format Cells dialog
makes it a bit fiddly.

Here’s a trick you may prefer to use instead:

:

:
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Make sure the
column is wide
enough

Explanations 
can be helpful

You can add
notes to cells
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After pressing to leave the cell, you may find that
Excel has seemingly ignored your line breaks and wrapped
the text in its own way instead. If so, the reason is that the
column containing the cell is too narrow: just widen the
column, and when it’s wide enough, Excel will revert to
using the line breaks you entered.

Add Quick Notes and Hints to a Cell
If you have a spreadsheet that contains just figures, over
time you may forget how you arrived at those numbers or
what particular figures were supposed to represent.

In these situations, Excel’s ‘Note’ feature is useful, and it’s
easy to use. Select the cell to which you’d like to add a note,
right-click the cell and choose New Note. A little yellow box
will appear beside the cell, with your name shown at the top
of it, and you can type any text you like as a comment
associated with that cell.

After typing the note,
just click anywhere
outside the yellow
box and its text will
be saved. You can
recognise cells that
have an associated comment by the little red triangle that
appears in the top-right corner of the cell.

Enter

If you know in advance that the text you’re about to
type will be too wide for the cell and will need line
breaks, you can type them as you go: when you reach
a point in the text where you want to start a new line,
press + .Alt Enter
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The mouse
pointer must be
over the cell

An alternative
solution

Type your note
for the cell

The drawback to this system is that the little triangle isn’t
particularly obvious, and the note itself only appears if you
move the mouse pointer over the cell. So, if you tend to
move around your spreadsheet using the keyboard rather
than the mouse, you might never see the note.

Fortunately, Excel offers an alternative to these notes, one
that many users won’t have come across called an ‘Input
Message’. Using this option, the note appears whenever the
cell is selected, whether you select it using the mouse or the
keyboard.

Here’s how to use the Input Message feature:

1.  Select the cell to which you’d like to add a message.
2.  Switch to the Data tab on the Ribbon. 
3.  In the ‘Data Tools’ group click the Data Validation

button.
4.  In the Data Validation dialog that appears, pictured

in the next screenshot, switch to the Input Message
tab .

5.  Make sure there’s a tick beside Show input message
when cell is selected , and then use the two
boxes below to type a short title for the message (if
you want to include one) and the text of the message
itself .

6.  Click OK to confirm the text you’ve typed and close
this dialog .

1

2

3

4

:
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The message
remains visible

From now on, whenever you select the cell you chose in
step 1 above, you’ll see the Input Message you just entered
in a little box beside or below the cell, and it will remain
visible until you select a different cell. The ‘title’ (if you
entered one) appears in bold text with the message text in
ordinary type below it.

Adjust the Widths of Columns in a Jiffy
Every time you start work on a new spreadsheet, Excel
makes each column the same width. As you enter data into
the cells, you can make columns wider or narrower as you
need to, but there’s an extra-quick way of doing it that saves
you the need to play around with each column’s width
individually:

1

2

4

3
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Move to the 
join between
columns

Double-click

1.  Select one or more columns in your worksheet. To
select a single column, just click the column letter at
the top; to select several columns, press the left
mouse button on the leftmost column letter and then
drag the mouse pointer to the right until all the
required columns are selected.

2.  Now place the mouse pointer over the join between
two of the selected column letters, or the join
between the selected column and the column to its
right. When you’re over the join, the mouse pointer
will change to a horizontal double-arrow shape with
a vertical line through it, as pictured below.

3.  Now just double-click. Excel automatically resizes
the selected column (or columns) to make them
exactly the right width for their contents.

:
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See Important Changes Instantly with
Conditional Formatting
It’s in the nature of spreadsheets that figures change auto-
matically: you add or alter a figure somewhere and Excel
updates the cells containing formulas. Some of those
changes might be important, so perhaps you’d like your
attention to be drawn to them?

To give you an example, you might have a spreadsheet in
which you keep track of your monthly income and
outgoings, with a cell that shows your running balance
(income minus expenses). If that cell ever shows a negative
figure, it means you’re running at a loss, so you’d like to be
sure you notice that.

An Excel feature named Conditional Formatting can do that
for you. In a nutshell, you select a cell, specify a ‘condition’
(such as the cell’s figure being less than zero), and specify
‘formatting’ to be applied if that situation occurs (such as
making its text red, or its background yellow) to ensure it
catches your eye.

Here’s how to set up Conditional Formatting using that sit-
uation as an example:

Have your
attention drawn
to changes in
cells

Use Conditional
Formatting

1.  Select the cell you want Excel to watch for changes
(or, if you prefer, select multiple cells or an entire
row or column).

2.  On the Home tab of the Ribbon, in the ‘Styles’ group,
click the Conditional Formatting button.

3.  Move the mouse to Highlight Cells Rules.
4.  On the submenu, choose Less Than (because in our

example we want to watch out for the figure in our
cell being ‘less than’ zero). You’ll notice you could also
choose Greater Than, Between or Equal To, allowing
you to specify any situation that might occur.

:
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Specify the
target figure 
to watch for

Choose
formatting for
this cell

5.  In the little Less Than dialog that appears, type the
number 0 in the ‘Format cells that are LESS THAN’
box (since that’s the number we want Excel to watch
for), then open the drop-down list to its right and
choose Custom Format.

6.  Now you’re looking at the Format Cells dialog where
you choose how the chosen cell should look when
its figure does drop below zero. You’ve arrived at its
Font tab, and here you might like to specify that the
text in the cell switches to bold or italic, or changes
colour.

7.  On the Border tab you can specify a particular style
and colour of border that should appear around the
cell when the condition is met.
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You’ve finished, and this Conditional Formatting takes effect
immediately. If you make a change somewhere in this
spreadsheet that results in that cell’s figure dropping below
zero, it immediately takes on the formatting you’ve chosen
for it, and it remains that way until another change lifts the
figure above zero again.

If you want to change the conditional formatting you’ve set,
select the cell, click the Conditional Formatting button on
the Home tab again and choose Manage Rules: here you can
select the rule you’ve just created and choose Edit Rule to
make changes to it.

If you want to remove the conditional formatting from the
cell, select the cell and then choose Conditional Formatting
> Clear Rules > Clear Rules from Selected Cells.

Work Faster by Naming Important Cells
When you’re writing formulas to add totals and so on, you can
spend quite a time scrolling around to find the cell references
you need. For instance, perhaps you need to add the figures at
the bottom of your first three columns, so you have to scroll
down, determine that they’re (say) A32, B19 and C26, then
remember those references as you type your formula:

=A32+B19+C26

Even worse, perhaps you’re totting-up figures from different
worksheets, so that as well as finding those references you’ve
some unwieldy typing to contend with:

Done

Edit the
conditional
formatting…

…or remove it

Difficulty finding
and remembering
cell references?

8.  On the Fill tab you can choose a background colour
for the cell.

9.  Having chosen your formatting for the cell, click OK.
That takes you back to the little Less Than dialog:
click OK here too.
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=Sheet1!A32+Sheet2!B19+Sheet3!C26

Wouldn’t you prefer to type something like this instead?

=TotalApril+TotalMay+TotalJune

It’s absurdly easy to do, and it brings all sorts of benefits.
When you’re writing formulas, it obviously means you’ll be
dealing with meaningful and memorable names, so you’ll
spend far less time looking up cell references. And when you
refer to an old spreadsheet (or send one to someone else),
those names will make it a lot easier to understand what’s
going on in your formulas.

Naming a cell is a simple three-step job:

Give names to
important cells!

1.  Click the cell you want to name .

2.  Click in the ‘Name Box’ at the far left of the
formula bar, which currently shows that cell’s
reference and in its place type whatever name you
choose for the cell . 

3.  Press to confirm it and you’ve finished.

1

2

3

Enter

32

1

:
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